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System Requirements

It contains two parts:

• ISC Console Software
• ISC Server Instrumentation Software

ISC Console Software allows interaction with the managed server.  It can be installed on these
system configurations:

• Windows NT† 4.0 server or workstation Enterprise Edition
• Windows† 95/98 workstation

ISC Server Instrumentation Software, when installed, creates a managed server that can be
managed from the system running ISC Console Software.  It can be installed on these systems:

• NetWare† server
• Windows NT 4.0 server
• UnixWare† server

Both the managing console(s) and the managed server(s) must meet the minimum system
requirements listed below.

Managed Server Requirements
ISC supports several Intel® motherboards.  For a complete list of supported server motherboards
and qualified BIOS revision levels, see the ISC release note files (README.TXT and
ERRATA.TXT).  The following requirements must be met for the NetWare, Windows NT, or
UnixWare managed server.

NetWare Requirements

If you intend to manage a NetWare server, you must have an account with supervisor- or
administrator-equivalent rights available to you.  The server must also meet the following minimum
requirements:

• NetWare 4.11 or 5.0 symmetric multiprocessing (SMP)
• One of the Intel motherboards specified in the release notes
• At least 24 MB of RAM
• At least 60 MB of available disk space
• NetWare SNMP NLM installed (required only for connectivity to an SNMP management

console)
• TIRPC (Transport Independent Remote Procedure Call) needs to be installed and configured

before an ISC console can communicate with NetWare servers.
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Windows NT Requirements

If you intend to manage a Windows NT server, you must have an account with administrative rights
available to you.  The server must also meet the following minimum requirements:

• Windows NT Server 4.0 (SP 4), or Enterprise Edition
• One of the Intel motherboards as specified in the release notes
• 32 MB of RAM
• 60 MB of available disk space
• Windows NT SNMP or SNMP service installed (required only for connectivity to an SNMP

management console)

SCO† UnixWare Requirements

If you intend to manage a UnixWare file server, you must have an account with root privileges
available to you.  The server must also meet the following minimum requirements:

• SCO UnixWare 7.01
• One of the Intel motherboards supported under UNIX† as specified in the release notes
• 32 MB of RAM
• 60 MB of available disk space
• UNIX SNMP and ONC RPC installed

Additional Requirements for DMI-SNMP Translation

SNMP support must be installed if you want to integrate ISC with an SNMP-based management
framework.  For SNMP installation information, see your Windows NT, NetWare, or UnixWare
documentation.

On the managed server, you should consider the following issues when configuring SNMP:

• Community string names for SNMP Get and Set operations and for sending traps
• The destination address for the management console receiving the traps

On the management console, you should consider the following issues when configuring SNMP:

• Compiling the MIBs into the SNMP management consoles
• Integration of ISC traps into SNMP management consoles

Console Requirements
The ISC Console software integrates into HP Network Node Manager, Intel® LANDesk® Server
Manager, or CA Unicenter-TNG consoles.  See ISC release notes for supported versions of these
software packages.  ISC also runs in a stand-alone environment.  You can choose to install the
stand-alone environment during Setup.  If you do not choose the stand-alone environment and no
management console is present, the ISC GUI software will not install.
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Windows 95
• Intel® Pentium® microprocessor or higher
• At least 32 MB of RAM
• At least 10 MB of available disk space
• Remote Registry service installed*
• Internet Explorer 4.0 SP2 or greater
• DCOM95 installed*
• Winsocket 2.0 installed*

Windows 98
• Intel Pentium microprocessor or higher
• At least 32 MB of RAM
• At least 10 MB of available disk space
• Remote Registry service installed*
• DCOM98 installed*

Windows NT
• Windows NT Server or Workstation 4.0 (SP4)
• Intel Pentium microprocessor or higher
• At least 64 MB of RAM
• At least 10 MB of available disk space

* For step by step installation, see the ISC release note files (README.TXT).
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Installing ISC

Managed Server Preparation
ISC uses the event-logging feature of the BIOS for system management status and information.  To
enable this feature for each server to be managed with ISC, you must boot the server(s) using the
System Configuration Utility (SCU) or System Setup Utility (SSU) and set the appropriate options
under System Management Options.  For motherboard-specific settings and values, see the ISC
release note files (README.TXT and ERRATA.TXT).

✏ NOTE

It is possible to configure temperature and voltage thresholds on the server
system using the SCU or SSU.  However, the thresholds set with the SCU or
SSU are in effect only for a short time during the system boot process.  ISC
overwrites these thresholds when the OS loads.  We therefore recommend
that all threshold changes be made using ISC.

Compatibility and Upgrade Issues
If you have earlier versions of LSC or LDSM on your network, be aware of the following:

• Versions of LSC integrated with LDSM (e.g., LDSM with LSC55 are not supported under ISC.
• The ISC-managed server installation will not upgrade the DMI service provider or any DMI

database that is already installed on the managed server.  However, if a service provider is not
found, ISC installs a DMI 2.0 service provider.

• The ISC server installation process installs the remote procedure call (RPC) transports (DCE
and ONC) if they are not available on the managed server.

Beginning with version 1.8, ISC ships with the DMI 2.0s Service Provider for Windows NT.  The
2.0s version is an extension of the Service Provider that supports security.  ISC does not use those
features, but they are available under Windows NT for possible use by other DMI 2.0s-compliant
software.

The Setup Program
The Setup program installs the ISC software, the stand-alone ISC Console, and the ISC Server
Instrumentation software for Windows NT and NetWare servers.  To install the instrumentation
software for UnixWare servers, please refer to the section “Installing to a UnixWare Server.”

✏ NOTE

Before running Setup, verify that you have administrative rights for all
servers and consoles on which you will be installing ISC.
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To start Setup:

1. Close all applications except the Windows Program Manager.
2. Run ISCSETUP.EXE.  If ISC was downloaded via the World Wide Web, run INSTALL.BAT

to rebuild and launch ISCSETUP.EXE.
3. Follow the Setup prompts.

The ISC Setup program configures both the Local Console and the Managed Server(s), through
four installation options:

• Local Console—Installs and sets up the ISC console components on the local system; detects
whether any supported enterprise management consoles are installed; and configures the ISC
console components to launch from these management console applications.  This option may
be selected only on a Windows NT server or workstation, or on a Windows 95 or a
Windows 98 workstation.

• Stand-alone environment—Installs and sets up the stand-alone ISC environment on the local
server; and configures the ISC console components to launch from this application.  This option
may be selected only on a Windows NT server or workstation, or on a Windows 95 or a
Windows 98 workstation.

• Local Server Instrumentation—Installs and sets up the ISC server components on the local
server.  This option may be chosen only on a Windows NT server.

• Remote Server Instrumentation—Installs and sets up the ISC server components on the
selected remote servers.  ISC supports a remote concurrent installation process (from a
Windows NT system) by allowing you to configure drive mappings to multiple remote servers
during Setup.  This allows you to install ISC onto multiple remote servers at the same time.
This option may be selected for either a Windows NT or a NetWare server.

Local Console Overview
Setup does the following:

• Creates necessary directories.
• Copies installation files to the Local Console.
• Registers the ActiveX controls.
• Configures the system, including registry changes.
• Configures ISC to run under HP NNM, Intel LANDesk Server Manager (LDSM) , or CA

Unicenter-TNG, if these management consoles are installed.
• Configures ISC to run in a stand-alone environment if the stand-alone environment is installed.
• The ISC Console software runs under Windows NT 4.0, Windows 95, and Windows 98.

When the ISC Console is installed on a Windows NT 4.0 server, the server can act both as a Local
Console and as a Managed Server if the server contains an ISC-supported motherboard and you
install the instrumentation software and the Local Console software.
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The ISC Console software is launched from enterprise management consoles that are detected
during Setup and configured to run ISC.  ISC supports these consoles during Setup (see the ISC
release notes for supported versions of these software packages):

• HP Network Node Manager: Windows NT only
• LANDesk Server Manager: Windows NT, Windows 95, and Windows 98
• CA Unicenter-TNG: Windows NT only

✏ NOTE

ISC also installs the DMI Explorer browser under HP-NNM, CA Unicenter-
TNG, and the ISC Stand-alone environment.

Setup will automatically configure each detected enterprise management console to launch ISC.  If
more enterprise management consoles are installed later, you must rerun the ISC Setup program to
configure the ISC Console software to run under the additional management console.  If Setup does
not detect any of the enterprise management consoles on the local machine or you have not chosen
to install the ISC stand-alone environment, the ISC console components will not be installed.

Stand-alone ISC Console Overview
Setup does the following:

• Creates necessary directories
• Copies installation files to the Local Console
• Registers the ActiveX controls
• Configures the system, including registry changes
• Configures ISC to run in the stand-alone environment

Use the ISC stand-alone environment to manage your servers without having an enterprise
management console installed on your local server.  The stand-alone ISC Console runs under
Windows NT 4.0, Windows 95, or Windows 98, either as an executable program, an ActiveX
control inside of a 32-bit Internet browser, or inside of the Microsoft Management Console (MMC).
Using the stand-alone environment, you can discover ISC-managed servers and run the ISC
Console software for those managed servers.

Managed Server Configuration
Setup does the following:

• Creates necessary directories
• Verifies software dependencies and configuration
• Installs DMI 2.0 service provider if no DMI environment is detected
• Detects the motherboard and chassis type
• Copies installation files to the server



12 Installation Guide for Intel Server Control v1.9

• Edits system startup files
• Sets up and configures the system, including registry changes
• Reboots the server

On NetWare servers, you must manually reboot the server to complete the ISC installation.

Local Server Instrumentation

Select this option so that Setup will install the ISC Instrumentation software directly on the server
from which Setup is initiated.  The option is valid for a local server running Windows NT 4.0.
With this option, Setup:

• WILL upgrade the motherboard instrumentation if a previous version is found.  The old
instrumentation is saved in a BACKUP directory.

• WILL install the DCE RPC transport if it is not available on the local server.
• WILL NOT install any ISC server instrumentation if Setup determines that the local machine

does not have a supported motherboard.

It is possible to configure both the Local Server Instrumentation and the ISC Console software on
the same Windows NT server.  Windows NT 4.0 servers can act both as managed servers and as
ISC Consoles.

Setup checks for DMI services on the local server.  Setup will not upgrade a DMI service provider
or a DMI database that is already installed on the local server.  If a DMI service provider is not
found, ISC installs a Win32† -based DMI 2.0 service provider on the local server.

Remote Server Instrumentation

Select this option to install the ISC Instrumentation software at one or more remote Windows NT
servers, one or more NetWare servers, or a combination of Windows NT and NetWare servers.
Remote install is supported from a system running Windows NT.  For UnixWare servers, refer to
the corresponding section for installation instructions.  With this option, Setup:

• WILL upgrade the motherboard instrumentation.  If a previous version is found, the old
instrumentation is saved in a BACKUP directory.

• WILL install the RPC transports (DCE or ONC) if they are not available on the remote server.
• WILL NOT install the ISC server instrumentation if Setup determines that the remote machine

does not have a supported motherboard.

In order to install ISC Instrumentation on a remote server, you must configure remote drive
mappings to servers on which you want to install the ISC server instrumentation.  Requirements:

• You must have administrator or equivalent rights for each server on which you will be
installing the software.

• You may have to create a network share on the remote server depending on which drive or
directory you want to install ISC onto.

• You can use your own named network share, or use the default share for the drive.
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After you manually configure the remote drive mappings to your installation directory, Setup will
simultaneously install the ISC server instrumentation to each server.  Setup creates a long-term
connection to the remote machine when you configure the remote drive mappings.  The mapping
continues once the ISC installation is complete.  You must manually delete unwanted drive
mappings.

Setup checks for DMI services on the remote server.  Setup will not upgrade a DMI 2.0-based
service provider or DMI database if one is already installed on the remote server.  If no DMI
service provider is found, ISC will install a Win32 or NetWare-based DMI 2.0 service provider on
the remote server.

Installing on a Windows NT Server
The Setup program automatically creates directories, copies files, updates registry entries, and
configures services.  Setup will reboot the server to complete installation.

Installing on a NetWare Server
Setup updates NetWare servers in two parts:

1. Files are copied to the NetWare server from the computer from which Setup is initiated.
2. After Setup has finished copying files to the NetWare server, you must reboot the NetWare

server to complete the ISC installation.  Following the reboot, a configuration and setup
program runs at the NetWare server.  The ISC configuration and setup program detects the
motherboard type and installs the ISC software.

If an ISC-supported motherboard is not detected during the ISC configuration and setup process, all
ISC-related files are deleted from the NetWare server.  A warning message is displayed on the
NetWare console indicating that ISC did not install correctly.

The ISC configuration and Setup program adds a call, ISC_ON.NCF, to NetWare’s
AUTOEXEC.NCF.  This allows the ISC server instrumentation NLMs to automatically load with
the NetWare OS.  To start the ISC server instrumentation, you can manually start ISC_ON.NCF, or
reboot the server to start the ISC server instrumentation automatically with the NetWare OS.

NetWare Server Customization After Running Setup

While installing ISC, the configuration and Setup program installs Adaptec and LSI (Symbios)
SCSI, and Intel LAN Adapter instrumentation on the NetWare server but does not enable the
instrumentation support.

To enable support for any or all instrumentation, you must edit the ISC_ON.NCF file in the
SYS:SYSTEM directory.



14 Installation Guide for Intel Server Control v1.9

To enable the Adaptec SCSI instrumentation, remove the word REM from these lines in the
ISC_ON.NCF file:

REM load iomgr

REM load cio20

REM load ciodmi

To enable the Intel LAN Adapter instrumentation, remove the word REM from these lines in the
ISC_ON.NCF file:

REM load intelndm

REM load intel_ni

To enable the LSI (Symbios) SCSI instrumentation, remove the word REM from these lines in the
ISC_ON.NCF file:

REM load symcinw

Installing on a UnixWare Server
Installation for UnixWare servers must be done on individual servers locally, not by using ISC
Setup.

You must be logged on as root.

The UNIX package will be installed by default in /isc directory.  If you want to install it in a
different directory, edit the file /var/sadm/install/admin/default, and change the value of basedir
parameter to “ask” rather than “default.” In this case, pkgadd will prompt for the base directory—it
will create the directory isc inside that.

Mount the CD-ROM in read-only mode.  To mount the CD-ROM, run “mount –rF cdfs
/dev/cdrom/* /install” or, if more than one CD-ROM driver is present in the system, note the name
of the driver from directory /dev/cdrom, and replace * with the driver name in the mount command.

To install the UNIX package:

1. Run “pkgadd –d /install/ISC/UNIXWARE/ISCUW.PKG”.  Commands are case-sensitive.
2. If the system motherboard is S450NX and if the board supports ICMB, set execute permission

to the files isc/eif and isc/asyncpoller.
3. Change directory to "isc." The default path is /isc.  Use the command "chmod +x eif

asyncpoller."

Once the installation is complete, reboot the system.  All the ISC daemons will be up and running
minutes after the system is up.  The daemons are dmispd, oncsp, basebrd, lra, sdlink, and sdtrap.
On ICMB enabled servers, the eif and asyncpoller are optional modules as explained above.
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Installing the Console on a Workstation
The Setup program installs the Local Console and the stand-alone ISC Console on a workstation.
The program automatically creates the directories, copies files, updates registry entries, and
configures services.  Setup will reboot the server to complete installation.

You must have Administrator or equivalent rights on the workstation in order for the ISC Console
programs to install properly.

Uninstalling ISC
The uninstall process differs between Windows NT, NetWare, and UnixWare.

Windows 95, Windows 98, and Windows NT 4.0

To delete the ISC components, run the Add/Remove Program function from the Control Panel on
the local server, and select the following programs:

• Intel Server Control Console—deletes the ISC console, including the enhanced GUI and
2.8-based applet, DMI browser, and enterprise management console files.

• Intel Server Control Instrumentation—deletes the ISC server platform instrumentation.
• Intel DMI 2.x Service Provider—deletes the DMI 2.0 service provider, DMI database, and

RPC transport files.  Do NOT delete this component if other DMI applications are installed
on the server.

It is recommend that you reboot the server after uninstall.

NetWare

To delete the ISC server instrumentation component, log on to the local server as a user with
administrative rights, and run the following two scripts from the SYS: SYSTEM directory:

• ISC_RM.NCF—deletes the ISC server platform instrumentation.
• DMI_RM.NCF—deletes the DMI 2.0 service provider, DMI database, and RPC transport

files.  Do NOT run this if other DMI applications are installed on the server.

It is recommend that you reboot the server after uninstall.

SCO UnixWare

To delete the server instrumentation, login as root.  Run “pkgrm” and follow the instructions.
Afterwards, reboot the machine.
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Launching ISC

ISC can be launched from and can manage your server from one of these enterprise management
environments:

• LANDesk Server Manager (LDSM)
• HP Network Node Manager
• CA-Unicenter TNG

Once the ISC GUI application is launched from an enterprise management console, the
management console application can terminate, and ISC will continue to operate normally.

ISC can be launched from and can manage your server from a stand-alone ISC Console.  The ISC
Console can run as an executable program, as an ActiveX control within an Internet browser, or
within Microsoft Management Console.

LANDesk® Server Manager
The LDSM console dynamically builds its feature set when communication is established with a
managed server.  If the managed server is running the ISC Component Instrumentation software,
the LDSM console adds an option for “Intel Server Control” as a launch point in the Tools branch
of the LDSM navigation tree.  Select this option to launch the ISC applet.

HP Network Node Manager
The HP Network Node Manager Console autodetects servers running the ISC Component
Instrumentation software.  The Console updates the server bitmap with an ISC server icon for those
servers.

To launch the ISC applet, select an ISC-enabled server on the HP Console network map, and then
select the "Intel Server Control Applet" option from the Tools Menu.  Alternatively, you can launch
the ISC applet by selecting an ISC-enabled server on the HP console network map, clicking the
right mouse button, and then selecting the "Intel Server Control" option from the popup menu.

CA-Unicenter TNG
The CA-Unicenter TNG Console autodetects servers running the ISC Component Instrumentation
software if you have enabled the ISC to CA discovery service.  To enable discovery, you must start
the "Intel Tng-ISC AutoDiscovery" service.  You can start this service from either the TNG
Unicenter "Auto Discovery" dialog or from the Windows NT "Services" applet.
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The "Intel Tng-ISC AutoDiscovery" service creates a new "Intel Server Control" TNG object for
each server having the ISC Component Instrumentation software.  That TNG object displays on the
map as a child of the "ISC World View" and as a child of the ISC-enabled server.  You can view all
ISC-enabled servers under the "ISC World View."

To launch the ISC applet, right-click on a "Intel Server Control" icon, and select the “Launch ISC"
option from the popup menu.

Stand-alone ISC Console
Use the stand-alone ISC Console to manage ISC-enabled servers without installing an enterprise
management console application.  The environment is implemented as an executable program; as
an application within Microsoft Management Console; or as an ActiveX control that runs within a
“container” application, such as Microsoft Internet Explorer, versions 3.0 or 4.0, or Netscape
Navigator, version 3.0 or 4.0.

Refer to Appendix A for details about the features supported by the stand-alone ISC Console.

Launching the ISC Console

To launch the stand-alone ISC Console in its own container, do the following:

1. From the Start Menu in Windows, select Start->Programs->Intel Server Control Tools->Intel
Server Control.

Launching the ISC Console with Internet Browsers

To launch the stand-alone ISC Console within a Web browser, do the following:

1. Run the Internet Browser to be used as a “container” for the ISC Console.
2. Within the browser, choose File->Open.
3. Enter the ISC Console filename, specifying the full path to the file:

%ISCPATH%\MI\EMC\IC\ISC.HTM

The stand-alone ISC Console will be started as the active application within the default Web
browser.

Once the ISC Console is loaded, the location can be saved as a “Bookmark” (Netscape) or a
“Favorite” (Internet Explorer) for easy access in later sessions.

You may also:

1. Locate the file using Windows Explorer, specifying the path:
%ISCPATH%\MI\EMC\IC\ISC.HTM

2. Double-click on the filename to launch the control within the default Web browser.

✏ NOTE

Netscape Navigator requires a plug-in for viewing ActiveX applications.
One that is known to work is ScriptActive†, which available from Ncompass
Labs, Inc. (see http://www.ncompasslabs.com).
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Launching the ISC Console with Microsoft Management Console

To launch the stand-alone ISC Console within Microsoft Management Console (MMC), do the
following:

1. From a Start Menu in Windows or from the StartÈRun selection, run MMC.
2. Within MMC, choose FileÈOpen.
3. Enter the ISC Console filename, specifying the full path to the file:

%ISCPATH%\MI\EMC\IC\ISC.MSC

The ISC stand-alone application will be started as the active application within MMC.  You may
also:

1. Locate the file using Windows Explorer, specifying the path:
%ISCPATH%\MI\EMC\IC\ISC.MSC

2. Double-click on the filename to launch the control within MMC.

✏ NOTE

If you have not installed MMC on your console system, you can obtain it
from Microsoft at http://www.microsoft.com/management/mmc/.
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